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INTRODUCTION

WHaAT 1s BripGe?

Bridge is a tool for viewing and interacting with a realtime data stream from CAT software.

Serup

The Bridge user’s computer is connected to the Court Reporter’s computer by a cable that
connects their serial ports. Multiple Bridge users may connect to a single court reporter by
splitting the cable. Other transmission setups are also possible, and the Bridge user may call
up transcripts from files stored on the user’s own computer (or network).

FeAatures

When following a realtime transcript, the Bridge user may interact with the transcript in a
variety of ways. When the reporter makes editing changes, the program is able to refresh the
transcript in realtime. With little effort or distraction, the user may make a simple mark,
insert a note, attach a file (a word processing document, a graphic file, a spread sheet, etc),
or set a coded issue mark at any point in the transcript.

Files can be saved, and multiple files can be viewed, with each file opening in a separate
Bridge window.

Basic Procepure

A typical realtime Bridge session might include five general steps:

1. Connect to the court reporter and open Bridge, which creates a new document.
Choose preferences for working with the transcript.
Connect to the transcript.

Follow and interact with the transcript during the proceeding.

A

Print, Export, or Save the file (optional).






THe Bripce Winpow

The Bridge Window consists of the Menu bar, the Tool bar, the text area, the Issue bar (with
buttons for Issue Codes 1-10), the Search bar, and the Status bar. The Tool bar, Search bar,
Issue bar, and Status Bar can be toggled on or off, by

selecting or de-selecting them in the View menu. Y v Tool bar
On the Status Bar are indicators of the cursor's Bont..  ShiftCri+ : iiifﬁfr
location in the document, the timecodes for that line of ;Ezz lcr:ut EE:+ v Staus har
the document, and the type of issue for any mark on Colors.  Ciri+D v Limecores
that line. There are also indicators for Caps Lock on or Spacing  Cirk2 y a:fkfumbers
off (CAP), Number pad lock on or off (NUM), and Autorscroll End v Keywords

L e R L L= = S e ——

Scroll lock on or off (SCRL).

7% BridgeDemo.brg - Bridge

File Edit Search View Help
09 yeQomL [ HE
Help \disualizer Connect Setup Seroll Cpen Save Prrint Copy Paste Keywards Index Play
001413 Q. (By Mr. Marshall) Let me explain that your 17:51:09 4
001/14 @ deposition today is being transcribed in real time, ’m
001415 thanks to our skilled court reporter here. Since the 17:51:21
001/16 attorneys are using a special program called BRIDGE, 17:51:24
00117 their computers are displaying an instant rough draft of 17:51:32
001/18 your deposition. This helps them to follow what you're 17:51:38
001/19 saying, make notes, and prepare questions that they will 17:51:44 2
[ (N T ey T
| Tt 68| o B[ QIR B 2| A S
For Help, press F1 Page 1, Line 19 17:51:44:15 CAP NUM SCRL

The size and position of the main window will be recorded so that when you close Bridge it
will open back up in the same place.

The page numbers are displayed on the left of every line as page/line (001/15).
Timecodes are displayed on the right side.

Notes display in a small border with a background color that defaults to light yellow to look
like a post-it note. If necessary, notes overlay the timecodes.






Quick Staar & Navicariv v BaipGe

Using Bridge to follow the creation of a transcript in Realtime, you can move around in the
document using the following keys and commands:

Serall

1.

2
3.
4

10.

The up (1) and down () arrow keys move the cursor up or down one line.
The Page up and Page down keys move the cursor up or down one screen.
The Home key moves the cursor to the beginning of the transcript.

The End key moves the cursor to the end of the transcript. You can also use the
“Scroll” Tool bar icon. If a Realtime session is in progress, the cursor goes to
the end and continues to follow along as text is created.

Note: If you scroll up, the bottom part of the screen automatically turns into a
split-screen scrolling realtime display. When you move the cursor back down,
the split-screen goes away. You can define how many lines of split-screen
scrolling realtime you want at the bottom in the settings dialog (the default is 5.)

Pressing the Enter key opens a Note dialog box and places a mark on the line
containing the cursor when you click OK in the Note dialog box. If there is a
mark already on the line, pressing Enter will re-open the Note dialog box so
you can edit your note.

Pressing the Space bar places a General mark on the line containing the cursor.
If there is already a mark on the line, pressing the Space bar removes the mark,
as long as you have not added a note. If there is a specific issue mark without a
note on the line, pressing the Space bar removes the mark. Pressing the Space
bar again will replace the mark.

Pressing a letter key places a mark on the line and lets you type in a note directly
in the note area to the right of the transcript window. If several notes overlap
vertically, the active note always displays on top.

Pressing the up (1) or down (] ) arrow key exits the note area and moves the
cursor up or down one line.

You can use the Search bar at the bottom of the window to search for any Text,
Location, Mark, Note, Issue, Attachment, Question, Answer or Speaker, using
the Find Next and Find Previous buttons after specifying what you want to find.

Additional buttons on the Search bar let you toggle on or off timecodes,
page/line numbers, marks, and keyword highlighting. Other buttons let you
adjust the line spacing and magnification (zoom in or out).

You can do a Quicksearch backward or forward using Speed keys or the
Search menu items to search for the previous or next Note, Mark, Issue,
Attachment, Question, Answer, or Speaker.

Speed keys for these and other features are listed in the Appendix, page .

In addition, clicking on the Help menu/Keyboard Chart opens, in Acrobat Reader, a one-
page chart showing the most commonly-used keyboard shortcuts and icons.






SerrcHING IN BRIDGE

UsinG THe SenrrcH BAR

R T —
Search for |Lacation v | |[Type pagefine or timecode] ~| &% e

For Help, press F1

The Search bar, located near the bottom left corner of the Bridge window, contains a Search
for selection list, so you can search your document for any of the Coameus | g |
following:

Text, Location, Mark, Note, Issue, Attachment, Question,

Answer, and Speaker. For Help, PfLDcitiDn L
Mar
Next to the Search for selection list is a combo box where you enter E;—':
the item you wish to find. For each type of search, the combo box will Attachment
suggest the information you should enter. After specifying the search Question
information (if needed), hitting enter will move your cursor to the next g;::'kir

occurrence of the item.
o Text Speed key: Ctrl+F

You can type text into the combo box and hit Enter to find it. The combo box lists the
text from the last 10 searches.

Text searches are whole-word matches and are case sensitive only if the search text
contains any capital letters.

e Location (Go to) Speed key: Ctrl+G or Ctrl+J
You can type a page/line or timecode.

e Mark
Searches for the next mark of any kind, whether it has a note or not..

o Issue R - , - | - , -
Selecting Issue opens the combo SxEninr J | [ S [=|
box listi.ng all of the issues for the For Help, press F1 P
current job, and you can select from 2: ~

. H
that list. 4
o
[:H
FH
[:H
9
10:
11:General




e Note

Searches for the next note, with the cursor in the note ready to edit. You have to option to
type note text to find.

e Attachment
With Attachment selected, hitting Enter finds the next attachment in the document.
e Question

With Question selected, hitting Enter finds the next Question paragraph in the document.
You can also enter text to look for in a question.

e Answer

With Answer selected, hitting Enter finds the next Answer paragraph in the document.
You can also enter text to look for in an answer.

e Speaker
With Speaker selected, hitting Enter finds the next Speaker in the document.

QUICKSEARCH

You also have the option of doing Quicksearches, which are commands that allow you to
perform searches with single keystrokes without using the search bar. The cursor will move to
the next line containing the selected search item. An exception is a Quicksearch for an issue: you
must select an issue from the drop-down list in the combo box.

Keystrokes for Quicksearch:

Quicksearch backward: Quicksearch forward:
F8 Note Shift+F8 Note
F9 Mark Shift+F9 Mark
F11 Issue Shift+F11 Issue
F12 Attachment Shift+F12 Attachment
Ctrl+Q Question Shift+Ctrl+Q Question
Ctrl+A Answer Shift+Ctrl+A Answer
Ctrl+R Speaker Shift+Ctrl+R Speaker

Quicksearches can also be accessed using the Search menu | Search menu | Quicksearch
backward backward and Search menu | Quicksearch forward options.



Menus

There are five drop-down menus in Bridge: File, Edit, Search, View, and Help

THe Fite Menu

Speed key: Alt+F

The File menu controls functions that affect the entire document. Use the File menu to
create (New), Open, Save, Print, rename (Save As), or Export a document. The File menu
also offers the options to Setup your connection settings and Connect to a realtime session.
The File menu also keeps a list of recently opened documents—a handy shortcut for getting
to frequently used files. To open one of the listed files, simply click on the filename
appearing on the recent-documents list.

New
Speed key: CtrI+N

This option opens a new, blank document. Use this when you want to start a new session. If
you already have a document loaded when you hit the "connect" button it ADDS the new
text to the existing document. You only use New if you want to start with a blank document.

Open . .. ‘
Speed key: CtrlI+O Toolbar button: ,/I/

Cpen

Opens the Open file dialog box:

Look jr: |_} Bridge ﬂ &= £ EE-
=1 Mame Size | Type
\Aﬁ File Falder

My Recent
Documents

Desktop

14 KB Bridge Docurment

by Documents

My Computer
@ = >
2
ty Metwark File name: |BridgeD emo.brg d Open |
Flaces
Files of type: |Bridge Files [*.bra] ﬂ Caneel

You use the Open option to view a previously saved file.



Save

Speed key: Ctrl+S Toolbar button:

Save

Saves a previously saved file. If the file has not been saved, the Save As dialog box opens,
and you can name the file and save it.

Save as . . .

Speed key: Shift+Ctrl+S

Opens the Save as file dialog box:

Save As
Save jn: |L'f) Bridge ﬂ |‘j‘ Ed-
. [S)Docs
e {fieridgeDemo.brg
My Recent
Documents
?'_'_'
[
Deskiop

My Documents

My Computer

My Nebwork File name: r'-JEeI.-'-.IfiIEe.tm
Flaces

Save

[ s |
Cancel

Ll Lo

Save as lype: |Bridge Files [*.brg)

This menu choice gives you the option to save the file with a different name or in a different
folder.

Setup . . .

Speed key: Ctrl+U Toolbar button: {'ﬁ;;.

Opens the Settings dialog box: Satup

Settings X

Protocal: ¢ Bridge ¢ Caseview © ASCIH

Method: © Commport @ File sharing

1 = Baud |38400 -

Mate column |60 *  Realtime lines |6 _I;I
ok | Mutimedia. | Cancel |
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Within the Settings dialog box:

The Protocol: radio buttons contain these choices:
Bridge
Caseview (Livenote/Summation)
ASCII

Comm port radio button: spin control to choose which COM port you will use
to attach to the computer running CAT software.

Baud rate drop-down list: 1200, 2400, 4800, 9600, 19200, 38400. Choose the
highest setting Bridge and the CAT software can both go. 38400 is usually
a good default value.

File sharing radio button: Check this when running Bridge on the same
computer as Total Eclipse™ or across a network. Total Eclipse™ will save
data into a file and Bridge will read data from that file in realtime.

Note column: specifies an arbitrary horizontal position for notes, expressed in
number of characters. The default setting is 60 but can it be adjusted larger
or smaller depending on how wide the margins in your CAT software tend
to be.

Realtime Lines: the number of lines of split-screen scrolling realtime you want
displayed at the bottom of the split-screen that appears when you scroll up
during a Realtime session.

Multimedia: Opens a Multimedia settings dialog to control the settings for the
audio file.

Multimedia settings @

Timecode affset: (0: 00:00:00
WA Mz 1000
Start time for this file: 12:34:17:08

Alternate media file path:

|
Cancel

When finished with settings, click OK to choose them, or Cancel to exit without
saving the changes.

11



Connect %J

Speed key: Ctrl+T Toolbar button: -

This opens the Open file dialog box, where you can choose the bridge file you wish to view.
You will use Connect to view a realtime file, Open to view a previously saved file.

Print E\l" - )
Speed key: Ctrl+P Toolbar button: o

This will print the entire Bridge file exactly as it appears on the screen, including the font
and other display information such as whether or not to show timecodes.

This printout will also include a report at the end, which lists the marks and notes and the
page and line numbers where they appear.

Any notes that are written will appear on the right side of the text. The notes will wrap to
several lines if necessary.

Export
Speed key: Ctrl+E
The Export function will export the contents of a Bridge file to an ASCII file.

€Exit
Speed key: Alt+F4

This function will close the program. If you have made changes to an open file, Bridge will
ask if you want to Save your changes before exiting.

12



Search  Wiew Help

THe €pir Menu Copy ctivc
Paste Clrl+y
Speed key Alt+E Quick mark Space or FS
: Issue code Issue 1l CirHl
Mote Enter or Insert Issue 2 CirH2
. . Attachiment Clr+y Issue 3 Crrk3
Contains commands appropriate to the file currently Dokt mark  Delate o F v beod Crltd
open. Listmarks  CirlL issue 2 Ctr:+5
Manage issues Cirl ssueg  Crko
Izsue 7 CtrH7
Issue 8 CtrH2
g OPV Issue 3 CirHo

Issue 10 CrH0

Speed key: Ctrl+C  Toolbar button: J
Copy

You can copy part or all of the document and paste it into any Windows software. Highlight
the portion of the document you wish to copy, using your mouse or Shift plus up or down
arrow keys, and choose Edit | Copy or Ctrl+C. Then open your word processing software
(Notepad, Wordpad, Word, etc.) and choose Paste (Ctrl+V) to insert the selected text.
Whatever is visible when you highlight the text (marks, timecodes, line numbers) will be
included in the copying process. If marks are included, the type of mark will be noted, and
any accompanying notes will also be displayed in the pasted document.

Paste
Speed key: Ctrl+V  Toolbar button: I

Paste

This option places text from the Windows clipboard into an annotation associated with a
mark in Bridge. First, place text from any source (word processor, spreadsheet, etc.) on the
Windows clipboard, using Ctrl+C. Place your cursor on the line where you want to place
the mark with the information, and choose Edit | Paste or Ctrl+V. A mark will be placed on
that line, with the text in the note.

Quick mark
Speed key: Space or F5

This option places a General mark at the cursor and lets you type a note without opening the
Note dialog. If you cursor to the line containing the mark, you can type or backspace
directly in the note area. Or you can press Enter to open the note dialog where you can edit
the note.

Note: You can add a mark to any line your cursor is on and type in a note simply by
beginning to type. When finished, the up or down keys will take you to the next or previous
line of text in the transcript.

Issue Code

Speed keys: Color-coded Buttons numbered 1-10 on the Issue bar.

You can stack multiple issues on one line, which will be 2:5ize iExhibit i
represented by stacked colored circles on the display. Issue buttons
toggle on, so when the cursor is on an issue-coded line you can see the toggled-in buttons as

13



well as the colored circles. Any issue can be toggled on or off at any time. The issue coding
can be done on a line whether it has a note or not, but the text of the issue code will appear
before the note text in the note box on the right side.

Note —
g

Speed key: Enter or Insert Toolbar button:
IF you press the Enter key, this box will open and allow you to

This option opens the Note dialog box. When you are in | [#2nattathelve containing tre cursor
the Note box, you can perform complex edits such as
copy/paste, etc.

Clicking OK closes the dialog and adds a General mark,
indicated by a black dot between the line number and the

teXt Cancel
003/19 @ ithas real value. For instance, sometimes you'll see - Hitting the Enter or Insert Key places a
003/20 me make a note in the rough draft on my screen or General mark with the Note text here.|
003/21 perhaps mark a spot as I'm listening to you. Call it 18:01

When the cursor is on the correct line for the note, it becomes the “active” note, and you can
see by the text color and a static cursor at the end of the text when you can type/backspace
into the note.

If several notes overlap vertically, the active note always displays on top.

Attachment
Speed key: Ctrl+Y

If you execute this command on an empty line, it will open a file dialog, and let you attach a
file. If the line already has an attachment, it will open it. To delete an attachment, you can
use the Delete command, just like deleting a note or mark. Eclipse will ask if you are sure
you to wish to delete the mark.

An attachment appears as a note containing the <<filepath>>. If there is a note on the line,
the filepath will be below the text of the note.

Delete mark
Speed key: Delete or F6

This option will delete the mark from the line at the cursor position. It will also delete any
associated notes, and attached files. If the note area is not empty, Eclipse will ask if you are
sure you to wish to delete the mark.

14



Manage Issues

Speed key: Ctrl +1

Use this command to open a list of issue codes, where you can
type in descriptions for 10 different issues, and can also select
issue colors, by clicking on the color to the right of the issue
description field, and selecting a color using the color dialog.
The colors are stored in the global Bridge settings; the issue
descriptions are stored with the document.

X

Appraisal

Exhibit

tL!LLLLLLL!

Cancel

15



THe Seanct Mewu

Speed key: AIt+S

Find
Speed key: Ctrl + F
This command places the cursor in the search data field on the search bar.

For the Text search, the combo box lists the text from the last 10 searches. Note allows you
to search for text inside notes. Text searches are whole-word matches and are case sensitive
only if the search text contains any capital letters.

find Previous
Speed key: Shift+F3 Toolbar button (on Search bar): 6@

This option will move the cursor to the previous instance of the specified search data.

Find Next
Speed key: F3 Toolbar button (on Search bar): 6@

This option will move the cursor to the next instance of the specified search data.

Heywords
Speed key: CtrI+K Toolbar button: ! &
Kewwords

This command displays an edit box for typing in keywords. Those keywords are then
highlighted on the screen wherever they appear in the text. All keywords are whole-word
matches and are only case sensitive if they contain any capital letters.

B

Word Index
Speed key: Ctrl + W Toolbar button:

16



Quicksearch backward and Quicksearch forward

. Quicksearch backward Hote F2
Speed keys: See graphic I'"“ SISl =
Duicksearch forward k Mark F2
These commands allow you to I F11
Go to.. CtrhG or Cirl+] S

perform searches with single
keystrokes without using the Play multimedia Clr+
search bar. The cursor will move

to the next line containing the

selected search item.

Attachment F12

Duestion Cir 0
Answer Cirl+a
Speaker CirH+R

F8 will take you to the previous Note, with the cursor in the note ready to edit.

F9 will take you to the previous Mark, whether it has a note or not.

F11 will send your cursor to the drop-down list of issues on the Search bar.

Go to..
Speed key: Ctrl+G or Ctrl+J

This keyboard/menu shortcut selects Location in the Search type selection list on the
Search bar, and puts the cursor in the search data field. This field will show a small
prompt to suggest what to do, such as [Type a page/line or timecode].

Play multimedia | r\
Speed key: Ctrl+M Toolbar button:

Play

This command will play the audio or video file associated with the transcript you are
viewing, if one is available.

17



THe View Mewu
Speed key: Alt+V

This menu contains commands appropriate to the file currently open, as well as the visibility
of components of the Bridge window.

ShOW/ ﬂ i d@ Shion Hide 3 v Tool bar
Font.. Shiftrcep | ¢ 22archbar
1 1 Zoom In Cirl + v Issue bar
This option toggles on or off the Tool bar, Search bar, o v Status bar
oo oL - =
Issue bar, Status Bar, Marks and Keywords. Colrs.,  CtHD v ;lmecodes
. . Spacin Ctrlh v Line Murnbers
It also controls the Timecodes and Line numbers. pacng v Marks
Auto-scroll End W Eengrds

Timecodes Toolbar button: | |

Selecting Show/Hide .. Timecodes cycles the display of timecodes from hours and minutes
(18:30) to hours, minutes and seconds (18:30:46) to off entirely. You can also toggle
through the timecodes options using the Toolbar button on the Search bar.

Note that the display on the Status bar shows Timecodes in hours:minutes:seconds:frames
(18:30:46:09).

Lline Numbers Toolbar button: 1 f_ﬂ

The Line Numbers On/Off toolbar button on the Search bar toggles the Page and Line
numbers display on and off. Page and Line numbers are displayed on the left of every line
as page/line (001/15).

Moarks Toolbar button: | &

This option toggles the display of marks and associated notes on or off.

Heywords Toolbar button: | 1'%

T,

This option toggles the highlighting of Keywords in the document on or off. The Keywords
themselves remain in the list unless deleted.

18



font i
Speed key: Shift+Ctrl+F Toolbar button: u

This menu choice opens the Font dialog box:

Font: Fart style: Size:

’E Regular 17 oK |
a A~
Aial Black i q Carcel

) drial Marraw
T &rial Rounded MT Bol Bold Italic "
B AvantGarde Bk BT 12
B BarkGothic Md BT 14
B Baskervile Old Face % -

Effects Sample
[ Strikeout

™ Underline Aa BbeZZ

LColor:
ek - Seript:

|\N’estem j

From here you can select preferences for:

Font
Font style ( Regular, Bold, Italic, Bold italic)
Size
Effects (Strikeout and/or Underline)
Script (Western or Hebrew)
Note that to change the color of the text, you use the View menu | Colors dialog.

Zoom In (magnify) F

| .

Speed key: Ctrl+ + Toolbar button: 7
Zoom Out =
Speed key: Ctrl+ - Toolbar button: 4

You can Zoom in and Zoom out, which works similarly to using successively stronger
(Zoom in) or weaker (Zoom out) magnifying glasses. The Zoom in and Zoom out buttons
on the Search bar control zooming.

Both buttons use a magnifying glass icon; the difference is that zoom in has a plus sign (+)
on it and zoom out has a minus sign. The zoom-in magnifies the display to show the
document in greater detail. The zoom-out reduces the display to show more of the document
in the available display area. Each click of a zoom button changes the display incrementally.

19



Colors [ Colors X

Speed key: Ctrl'l'D Text E | Questions

Selecting this menu option opens a Colors dialog, where N | sceckers NN enawcts
you can set the colors for Text, the color of the labels for

Text

il

Background
Speakers, Questions, and Answers, as well as the B | narmal k| keywords
Background colors for Normal text, the Current line, the ¢ |curentline  y |motes
split realtime window, highlighted Keywords and Notes. R | Realtime window

Spacing —h

Speed key: Ctrl+B Toolbar button:

Choosing this menu option toggles the line spacing of the document you are viewing,
moving through single spacing, 1.5 spacing, and double spacing. You can also use the
button located on the Search bar.

Auto-scroll

Speed key: End Toolbar button: sl
This menu option, speed key or Toolbar button sends the cursor to the end of the document.

Note: If you scroll up, the bottom part of the screen automatically turns into a split-screen
scrolling realtime display. When you move the cursor back down, the split-screen goes
away. You can define how many lines of split-screen scrolling realtime you want at the
bottom in the settings dialog (the default is 5.)

20



THe Herr Mevu

Speed key: Alt+H

Help Topics
Speed key: F1

Opens the Bridge Help file.

Visualizer
Speed key: Shift+F1

Toolbar button:

Opens the Introductory Bridge Visualizer file in your browser, with links to over 20
Visualizer movies covering various aspects of using Bridge. Except for a 5-minute overview
movie, most are designed to be watched with no audio.

Manual

Opens the Acrobat Reader version of the Bridge User Manual.

Heyboard Chart

Opens a one-page chart showing the most
commonly-used keyboard shortcuts and icons.
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Demo

This menu item starts a self-running demo

file. It acts exactly like a reporter writing ¥ Bridge Demo - Bridge

realtime into the system, including applying Eile Edit Search ¥iew Help

edits. It works by slowly reading in a X AN o |
demo.law file from the same folder where @ E Q‘/ m i~ l
Bridge is installed. You can use any .law e o N
file for a demo, so as an alternative to the stopdemo || Pausedemo | Faster | sower |
particular demo file that ships with Bridge, 001/01 BRIDGE demo. Press Ctrl K
you can prepare your own demo files to

show your clients to demonstrate your
work.

001/02 key words: BRIDGE, deposit
The demo function displays a toolbar along the top with [Stop demo][Pause demo][Faster]

[Slower] buttons.

About Bridge . . .

This menu option displays the Bridge version number and copyright information. This
information may be utilized during troubleshooting by ASI support.
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Areenpix A: Toowsar Burrons

Button Function Button Function
Help: Opens Help Copy: Places highlighted
@ file = J text into the Clipboard
Help Copy
o Visualizer: Opens Paste: Places the
‘ browser with 20+ | contents of the Clipboard

Visualizer

Visualizer movies

Paste

at the cursor position

X

Canneck

Connect: Connect to
Realtime data
stream

4

Keywords

Keywords: Opens a
dialog listing keywords
to highlight throughout
the transcript

Setup: Setup
communications

=

Play

Play: Plays, if available,
an audio or video file
associated with the
transcript

Scroll: Cursor to end
of transcript

Open: Opens a

,.Jf previously saved
Open transcript

Save: Saves the
u current transcript

Print: Opens the
Print dialog
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Areenpix B: Sreep Keys

Keystroke Function Keystroke Function
Ctrl+N New file Ctrl+G or Ctrl+J Goto ..
Ctrl+O Open file Ctrl+-M Play multimedia
Ctrl+S Save file Shift+Ctrl+F Font
Shift+Ctrl+S Save As.. Ctrl + Zoom in
Ctrl+U Setup .. Ctrl - Zoom out

Communication

Ctrl+T Connect Ctrl+B Colors..
CtrlI+E Export Ctrl+D Spacing
Ctrl+pP Print End Auto-scroll
Ctrl+C Copy F1 Help topics
Ctrl+Vv Paste Shift+F1 Visualizers
Space or F5 Quick Mark Alt+F4 Exit
Ctrl+1, Ctrl+2 ... Issue codes
Ctrl+0 -
Enter or Insert Note
Ctrl+Y Attachment
Delete or F6 Delete a mark
Ctrl+1 Manage Issues
Ctrl+F Find
Shift+F3 Find previous
F3 Find next
Ctrl+K Keywords

Quicksearch backward: Quicksearch forward:

F8 Note Shift+F8 Note

F9 Mark Shift+F9 Mark

F11 Issue Shift+F11 Issue

F12 Attachment Shift+F12 Attachment

CtrlI+Q Question Shift+Ctrl+Q Question

Ctrl+A Answer Shift+Ctrl+A Answer

CtrI+R Speaker Shift+Ctrl+R Speaker
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Areenpix C: Torat Ecurse” Serup Paocepure

This information is for the Total Eclipse™ user setting up to run Bridge. In order to send a
transcript to a user running Bridge, the Total Eclipse™ user must first add the Bridge settings
to Total Eclipse™.

1. Go to User Settings (Alt+U) | Realtime.

2. Your basic Realtime settings (Flush Delay, Pending translation display, Follow
always, and Division interval) will apply to the Total Eclipse™ document, and have
no bearing on the Bridge document.

3. In the Output format list box, see if Bridge/LawBridge/TeleView is listed.

If it is, select it, and choose Change.

b. Ifitis not listed, select Add, and the Output format dialog box will open.
From the drop-down list of Qutput formats, choose
Bridge/LawBridge/TeleView.

Qutput format: | ox |
Comm device: File sharing W [ Setup == ] Cancel
Output characteristics
[ ] apply edits [ ] &l caps ALto-dial Flush weard cetay

Allovwy backspaces

|:| Force mardine:

Timeout to blank

Left margin: |:| Vit time to blank
S EETE T I:I fax roves = I
Inclertation: |:| .
Header: hazimurm WaE
Foreground:
Aftribute: | Maormal w Background:
Caption channel m hode:
Encader: Hangup mode:

)




4. From the drop-down list of Comm device:, choose to send the output to a COM
port, or to send the text to a file on a network. The Bridge user or users can then
connect to the file on the network.

a.

If using a COM port, choose Com port:, and select Setup>>. Choose the
port you are using from the list, and set the Baud rate to 38K (38400).

If sharing the file over a network or running Bridge on the same computer on
which you are running Total Eclipse", choose File sharing, and select
Setup>>. The Browse for Folder dialog box will open, allowing you to
select the location for the shared file.

Browse For Folder

4+ |) Program Files ”
= |2 Advantage Software
+ | Bridge
= |2 EclipseNT
1 1) Documentation
+ |[[) Lessons
) Portable Macros
+ ([ Program Files

120 Spell
= ) Users
=1 HCap
J HRT
H [ HWilson b
[ ok | [ Cancel

5. Under Output characteristics, you can make choices that affect the way your text
will appear in the Bridge file.

a.

Apply edits: When selected, your editing changes will appear on the Bridge
output. The edits will be applied when the cursor moves to the next
paragraph.

Allow backspaces: Leave this option off if you do NOT wish to allow
backspace characters to back up over existing text. Note that you can still
delete one word in realtime even if this option is turned off.

Force margins: This option allows you to change the margins on the Bridge
display. When this option is off (the default setting), the text on the display
conforms to the paragraph margins set in User Settings | Paragraph.

All caps: This option sets the Bridge display to all capital letters.

Flush word delay: This option controls the amount of time (in milliseconds
—for example, 2000 milliseconds=2 seconds) the system will wait before
transmitting the very last word written. Each word will wait until the
following space is transmitted before it is displayed. Setting this to zero turns
the option off, and causes the system to wait indefinitely. You can set this
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6.

delay so that you will have the opportunity to delete a word the viewer has
not yet seen.

f. Header: You can type into this space a piece of text such as
“UNCERTIFIED ROUGH DRAFT” and that text will be transmitted to
Bridge at the beginning of every page.

g. Maximum WPM: This option sets a maximum speed that words are allowed
to display on the screen. If the written rate goes too high, this option will
begin intentionally pausing slightly between each word displayed. When the
written rate slows down, the display will continue and will catch up with the
reporter.

When finished with the output settings, close the User Settings dialog boxes.

Becinung A Reatrme/Bripce Session

1.

AR

Connect your writer to an available COM (serial) port on your computer. Connect
the Bridge user's computer to yours via serial ports; or log on to network to which
the output file will be transmitted.

Press AIt+T to open the Translate notes dialog.
Mark the Realtime radio button.
Click OK to begin the realtime job.

At this point, you or the other user(s) can open Bridge and connect to your output.
The Bridge user simply goes to File | Connect (Ctrl+T). See below for additional
Bridge settings.

When you are finished writing realtime, press Shift+Alt+T or use the Production
menu | Stop translation command.

Note: The realtime settings can be
made once and left alone for
subsequent realtime jobs. You do not
need to reset them each time you
open a realtime file.
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